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Legal information

Warning notice system

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert
symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are
graded according to the degree of danger.

A\DANGER
indicates that death or severe personal injury will result if proper precautions are not taken.

AAWARNING
indicates that death or severe personal injury may result if proper precautions are not taken.

A\ CAUTION
indicates that minor personal injury can result if proper precautions are not taken.

NOTICE
indicates that property damage can result if proper precautions are not taken.

If more than one degree of danger is present, the warning notice representing the highest degree of danger will
be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to
property damage.

Qualified Personnel

The product/system described in this documentation may be operated only by personnel qualified for the specific
task in accordance with the relevant documentation, in particular its warning notices and safety instructions.
Qualified personnel are those who, based on their training and experience, are capable of identifying risks and
avoiding potential hazards when working with these products/systems.

Proper use of Siemens products
Note the following:

A WARNING

Siemens products may only be used for the applications described in the catalog and in the relevant technical
documentation. If products and components from other manufacturers are used, these must be recommended
or approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and
maintenance are required to ensure that the products operate safely and without any problems. The permissible
ambient conditions must be complied with. The information in the relevant documentation must be observed.
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Preface

Purpose

Conventions

This document is part of the documentation of SIMATIC IPCs.

The document contains the following information:

® Using the SIMATIC IPC Wizard for widescreen devices

® |nstallation and use of the Panel Configuration Center

The following abbreviations of product names are used in this document:

Long form Abbreviation
SIMATIC IPC Wizard for Widescreen Devices IPC Wizard
SIMATIC IPC, SIMATIC BoxPC, computer PC
SIMATIC IPC, SIMATIC IFP Device

SIMATIC IPC touch/key, SIMATIC IFP Touch/Key

Keyboard unit

Windows Embedded Standard 7E, 7P

WES7E, WES7P

Windows 7 Ultimate

Windows 7

SIMATIC IPC Single-touch, SIMATIC IFP Touch,
Touch/Key

Devices with resistive single-touch screen

SIMATIC IPC Multi-touch, SIMATIC IFP Multi-touch

Devices with capacitive multi-touch screen

SIMATIC IFP Monitor

Monitor

Panel Configuration Center

PCC

Style conventions

Figures

Style convention Scope

"Add screen" .
commands

e Path information

User interface terms, for example, dialog names, tabs, buttons, menu

e Required inputs, for example, limits, tag values.

"File > Edit"

Operator actions, for example, menu commands, shortcut menu commands.

<F1>, <Alt+P> Keyboard operation

This document contains images of the software described. The images can deviate slightly

from the supplied software.

SIMATIC IPC Wizard 2.1 and Panel Configuration Center
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Trademarks

History

The following designations marked with the symbol ® are registered trademarks of
Siemens AG:

e SIMATIC®; SIMATIC HMI®; SIMATIC Industrial Flat Panel®; SIMATIC IPC®

e WinCC®

Edition

Comments

07/2014

First edition
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IPC Wizard 1

1.1 Product description

SIMATIC IPC Wizard for SIMATIC Industrial PCs installs device-specific software and
drivers for operating your PC. These software components enable you to set the screen of
your SIMATIC device, for example, the brightness.

The SIMATIC IPC Wizard recognizes the existing hardware components and automatically
installs the associated software.

® SIMATIC Industrial PCs with preinstalled software contain the SIMATIC IPC Wizard that
runs automatically during initial commissioning.

® On SIMATIC Industrial PCs without preinstalled software, you can install the SIMATIC
IPC Wizard from the CD/DVD "Documentation and Drivers" on which the documentation
of the SIMATIC IPC Wizard is located.

1.2 System requirements

Hardware requirements
For the SIMATIC IPC Wizard you require the following hardware:

® PC with connected SIMATIC display: e.g. SIMATIC Panel PC or PC with connected
SIMATIC Industrial Flat Panel

® 650 MB of free hard disk space on the PC, C:\ partition
® The SIMATIC IPC display is fully connected:
— DVI/ DP connection for video signals

— USB connection for touch signals

Note
Connected devices

The SIMATIC IPC Wizard does not support the combination of devices with resistive single-
touch screen and capacitive multi-touch screen.
Note for SIMATIC Industrial Flat Panels:

e If you use a SIMATIC Industrial Flat Panel with the PC, connect the Industrial Flat Panel
to the PC before initial commissioning.

e During initial commissioning, multiple Industrial Flat Panels may be connected to the PC.

SIMATIC IPC Wizard 2.1 and Panel Configuration Center
Operating Manual, 07/2014, ASE34984843-AA



IPC Wizard
1.2 System requirements

Supported operating systems
The SIMATIC IPC Wizard on PCs runs with the following operating systems:
® Microsoft Windows 32-bit operating system
— Windows 7 Ultimate with SP1
— Windows Embedded Standard 7E ' or 7P with SP1
® Microsoft Windows 64-bit operating system
— Windows 7 Ultimate with SP1
— Windows Server 2008 R2
— Windows Embedded Standard 7E ' or 7P with SP1

' For devices with capacitive multi-touch screen, WES7E is only supported in single-touch
mode (see section "Toggling Switch Touch Mode (Page 33)").

Software requirements

® One of the operating systems named in "Supported operating systems" section is
installed.

® The driver of the device manufacturer for the graphics adapter is installed.

® The installed graphics driver supports reading of EDID data from the screen.

Note
The Microsoft VESA driver is not supported by the SIMATIC IPC Wizard.

Setup cancels the installation.

SIMATIC IPC Wizard 2.1 and Panel Configuration Center
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IPC Wizard

1.3

1.3.1

Requirement

Procedure

1.3 Setup

Setup

Installing IPC Wizard

The|system requirements (Page|7) are met.

Do not apply with factory state: If following previous driver versions exist, uninstall them
via "Start > Control Panel > Programs and Features":

— IPC Wizard V1.0
— IPC Wizard V2.0
— |PC Switch Touch Mode V2.0.5

. Turn on the PC.

— With the factory state of some IPCs, the SIMATIC IPC Wizard is pre-installed. The
installation starts the first time the PC is switched on.

— If your SIMATIC IPC was delivered without pre-installed software, start the installation
of the SIMATIC IPC Wizard from the "Documentation and Drivers" CD/DVD. Select
the appropriate IPC Wizard for your device.

SIMATIC IPC WIZARD Setup is preparing the InstallShisld
F‘ Wizard, which will guide you through the rest of the setup

process. Please wait.

SIEMENS

2. Follow the instructions.

The SIMATIC IPC Wizard recognizes the existing hardware components and
automatically installs the associated software. This operation can take several minutes.

When all software components are installed, the following dialog is displayed:

SIMATIC IPC Wizard 2.1 and Panel Configuration Center
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IPC Wizard

1.3 Setup
Note
In the case of server operating systems the dialog contains the "Now" and "Later" buttons
instead of "OK".
3. Complete the installation with the "OK" button; for server operating systems use "Now".
The PC is restarted.
Result
You have installed the SIMATIC IPC Wizard software.
1.3.2 Changing, repairing, or uninstalling the IPC Wizard

Requirement
® The IPC Wizard is installed.

Procedure

1. Start the setup again with "Start > All Programs > Siemens Automation >
Start_IPC_WIZARD".

2. Select one of the following options:
"Modify"
Change the IPC Wizard: Add or remove software components.
"Repair"
Repair the IPC Wizard: Repair all software components
"Remove"
Uninstall the IPC Wizard: Remove all software components

3. Click the "Next" button.

SIMATIC IPC Wizard 2.1 and Panel Configuration Center
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IPC Wizard

1.3 Setup

4. Depending on the selected option, the IPC Wizard responds as follows:
"Modify"

The "Select features" dialog box opens.

SIMATIC IPC WIZARD - InstaliShield Wizard [

Select Features

Select the features setup will install

Select the features you want to install, and deselect the features pou do not want to install.

anel Configuration Certer L& Cnlion

W] Screensaver Panel Configuration Center far
[ Brightress SIMATIC IPCs/IFPs
[WIUPDDSettings
[l Phonek.eppad
[ K.enT oolsPhone

< Back ][ et = ]I Cahcel

L

Note

However, only the software components (features) supported by the detected
hardware are displayed.

Select the check boxes for the software components you want to add.
Clear the check boxes for the software components you want to remove.
Click the "Next" button.

- "Repair"

All installed software components of the IPC Wizard will be repaired. The progress is
displayed in the "Setup Status" dialog.

— "Remove"

All installed software components of the IPC Wizard will be uninstalled. The progress
is displayed in the "Setup Status" dialog.

Note

Before removing the SIMATIC IPC Wizard, switch back to multi-touch mode (see
section "Toggling Switch Touch Mode (Page 33)"). The driver for the keyboard
controller are also uninstalled at this time.

5. The message to restart your PC appears. Confirm the message with "OK". For server
operating systems, the dialog contains the "Now" and "Later" buttons instead of "OK".

SIMATIC IPC Wizard 2.1 and Panel Configuration Center
Operating Manual, 07/2014, ASE34984843-AA 11



IPC Wizard

1.3 Setup

1.3.3

12

Software components (features)

After installing the SIMATIC IPC Wizard and depending on the hardware, various software
components are available on the PC. You can individually activate and deactivate the
software components (see "Change the IPC Wizard..."):

Screensaver

Activate SIMATIC screen saver
Change screen saver settings
Activate transparent display

Adjust brightness value on wakeup

Brightness

Adjust the brightness value for selected or all devices

Adjust brightness value on system start

UPDDSettings

Configure clone mode including touch interlock
Configure extended mouse functions
Calibrate the touch screen and check the calibration

Display the status of the operator panel

PhoneKeypad

Alphanumeric keys similar to a cell phone

Preview window, which is displayed directly below each input box.

KeyToolsPhone

Set screen saver

Change function keys mapping
KeyTools

Shift key function on and off

Activate KeyToolsPhone at system start

SIMATIC IPC Wizard 2.1 and Panel Configuration Center
Operating Manual, 07/2014, ASE34984843-AA



Panel Configuration Center (PCC) 2

2.1 Product description

Along with the SIMATIC IPC Wizard, various software components are installed on your PC
depending on the device features, allowing you to configure the connected SIMATIC IPC
display. The Panel Configuration Center (PCC) provides a convenient interface for operating
these software components.

You can use the PCC to configure your device directly or open the respective setting dialog
of the operating system.

2.2 Overview

Requirement
® The IPC Wizard is installed.

® The System requirements (Page|7) are met.

Note
Device detection
If you connect another device during operation, for example, a SIMATIC Industrial Flat Panel

or if a device is not detected, close the PCC and open it again. The additional devices will
then be detected.

Note
Windows 7 Fast User Switch
Only one instance of the Panel Configuration Center (PCC) can be open at a given time.

This is why Windows 7 "Fast User Switch" for switching multiple simultaneous users is not
supported.

1. Close the PCC.
2. Open the PCC as a different user.

SIMATIC IPC Wizard 2.1 and Panel Configuration Center
Operating Manual, 07/2014, ASE34984843-AA 13



Panel Configuration Center (PCC)

2.2 Overview

Opening and operating the PCC

14

mn
CC
1. Click on the "Panel Configuration Center" icon on the Desktop.

Select "Start > All Programs > Siemens Automation > Panel Configuration Center > Panel
Configuration Center".

2. Change a setting directly on the interface. All settings are immediately applied and
permanently stored.

Depending on the device, device features are shown on the left in several tabs. These tabs
summarize one or more software components on the device (see section "Availability"):

PANEL CONFIGURATION CENTER
Menu About

Brightness

Screen saver

Touch setti
OUCH SEHNIS | A devices selected, Brightness 93 %

-

\_ \ Brightness value at system startup: 100 %

/| Use brightness value for all connected devices

e "Brightness" tab: Individual adjustment of the brightness of all connected devices, see
section SetBrightness (Page 17)".

)
® "Interlock" tab: The interlock prevents the simultaneous operation of multiple devices
during clone mode, see section "Interlock in clone mode (Page|31)"

e "Screen saver" tab: Activates and configures the "IPCScreenSaver" screen saver, see
section "IPCScreenSaver (Page 19)".

SIMATIC IPC Wizard 2.1 and Panel Configuration Center
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Panel Configuration Center (PCC)

Closing the PCC

2.2 Overview

® "Touch settings" tab for devices with capacitive multi-touch screen:

"Tablet PC settings": Opens the Windows "Tablet PC settings". You use a virtual
"OnScreenKeyboard" (OSK) from the operating system when using the tablet PC
functionality, for example, Windows 7 and WES7P.

Note

Extended monitor mode with two or more screens

To extend the Desktop with all connected touch devices, you must assign the touch
devices to the displays once under Windows:

1. Connect an external keyboard to the PC.

2. Inthe "Interlock" tab, disable the "Activate interlocks" option.

Click on the "Tablet PC settings" button.

Change to the "Display" tab.

Click the "Setup" button.

Touch the touch screen one after the other (display 1, 2, etc.).

To complete the assignment, press any key on the external keyboard.

N o oA~

"Switch touch mode™: Toggles between multi-touch mode and single-touch mode, see
section "SIMATIC Switch Touch Mode (Page 32)".

Screen display: Toggles all connected devices between portrait and landscape
orientation.

e "UPDD Settings" tab: Universal Pointing Device Driver (UPDD): Touch settings for
devices with resistive single-touch screen:

"Check calibration": Opens a test screen with buttons without function. Touch the
screen and try to activate the individual buttons. This helps to recognize the quality of
the screen calibration.

"Calibration": Immediately starts the 3-point calibration of the UPDD, see section
"Standard calibration (Page|25)".

"Settings": Opens the UPDD configuration menu (Page 22} with a variety of device
settings, for example, Extended calibration (Page 26), Touch functionality|(Page 27) or
the interlock mechanism in clone mode.

Close the PCC in the menu bar via "Menu > Exit".

SIMATIC IPC Wizard 2.1 and Panel Configuration Center
Operating Manual, 07/2014, ASE34984843-AA 15



Panel Configuration Center (PCC)

2.2 Overview

Availability
The following table shows the software components available for specific devices:
Devices
with capacitive with resistive with resistive single- | SIMATIC IFP Monitor
IPC Wizard software multi-touch screen | single-touch screen | touch screen and keys
component
UPDD - X X -
Panel SetBrightness X X X X
PC IPCScreenSaver X X X X
Tools
PhoneKeyPad - - X -
Switch touch mode X - - -
KeyTools - - X -
SIMATIC IPC Wizard 2.1 and Panel Configuration Center
16 Operating Manual, 07/2014, ASE34984843-AA



Software description 3

3.1

3.1.1

3.1.1.1

Overview

General for all devices

Panel PC Tools

SetBrightness

Adjusts the screen brightness for all connected and detected SIMATIC devices. Excluded
are devices that do not support the DDC interface or the brightness functions of the DDC
interface, for example, most older monitors connected via VGA.

Setting the display brightness

Procedure

The following figure shows the "Brightness" tab in the PCC and an example with two
devices, 1 and 2.

Note
Full device detection
Devices that are connected or removed during ongoing operation, appear or disappear in the

"Brightness" tab after restarting the PCC. You can adjust the brightness only when the
devices have been fully detected.

Deviating numbering

Depending on the graphics chip and operating system, the numbering of the devices may
deviate from the numbering in Windows:

Double-click on the device icon The associated device flashes several times in quick
succession.

SIMATIC IPC Wizard 2.1 and Panel Configuration Center
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Software description

3.1 General for all devices

Principle

. Open the PCC and go to the "Brightness" tab.

Select the device whose brightness display you want to change. In the example, device
"1" is selected, all other devices are not selected. If no device is selected, the display
brightness of all devices is changed to the same degree.

PANEL CONFIGURATION CENTER
Brightness
Touch settings i .
All devices selected, Brightness 93 %

Menu About
| I 2
| Brightness value at system startup: 100 %

/| Use brightness value for all connected devices

Set the desired display brightness. You have the following setting options:
— Using the slider. The set value is applied when you release the slider.

— Using the "Increase brightness (+)" and "Decrease brightness (-)" buttons.

Note

The minimum value for the brightness setting is 10%. If you select a value of less than
10% using one of the setting options, the brightness value is automatically set to 10%.

To set a fixed brightness value for all devices at every system startup - except for
hibernation, standby - select "Brightness value at system startup".

Enter the desired brightness in percent in the box on right. The setting is valid only for the
current user and first takes effect upon logon.

If you disable "Brightness value at system startup”, the brightness value set in step 3
takes effect.

If needed, enable "Use brightness value for all connected devices." Alternatively, click in
the empty box next to the device icon. Then the brightness is the same again for all
devices.

If the PCC is started and appears as an icon in the taskbar, you can change the icon
brightness using the small buttons in the preview window.

18

SIMATIC IPC Wizard 2.1 and Panel Configuration Center
Operating Manual, 07/2014, ASE34984843-AA



Software description
3.1 General for all devices

Command line call

Call parameters

The "SetBrightness" program can be called in the command line with the following options:
SetBrightness.exe

Note

In contrast to the graphical interface, the minimum value is set to 0 % in command line
mode. In this case, the backlighting is switched off. By pressing an input device, for example,
a touch screen or keyboard, the display is switched on again with 100% brightness value.
The first input event, for example, a mouse click, is discarded in this case to avoid an
unintentional incorrect operation.

[VALUE] parameter

The parameter must be specified for each command line call of the "SetBrightness" program.
The following options are available for selection:

Value Explanation
The brightness value specified by VALUE (0 ... 100) is applied.

Example: Calling c:\setbrightness.exe 50 corresponds to a brightness of 50 %.

31.1.2 IPCScreenSaver

Introduction

The SIMATIC "IPCScreenSaver" is a standalone software component that is installed via the
IPC Wizard. You can configure the screen saver on the PCC from which you open the
Windows standard dialog "Screen Saver Settings".

The "IPCScreenSaver" switches on after a configured time, e.g. 1 min. Then the brightness
of all connected devices is set to the configured value, e.g. 23%. In contrast to most
conventional screen savers, the "IPCScreenSaver" can save energy: The power
consumption of screens set to dark is less than screens with high or normal brightness.

NOTICE

Device no longer operable

When you select Activate 'IPCScreenSaver' screen saver and Windows screen saver are
activated at the same time, the device may become inoperable. This may damage the
machine or plant.

Disable the Windows screen saver: Under "Start > Control Panel > Power Options >
Choose when to turn off a display”, set the "Turn off display" option to "Never".

Note

If an additional device is connected to the PC during operation, the PC must be rebooted.
During the Windows startup, the additional device is detected and connected.

SIMATIC IPC Wizard 2.1 and Panel Configuration Center
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Software description

3.1 General for all devices

Procedure

1. Open the PCC and go to the "Screen saver" tab.

PAMNEL CONFIGURATION CENTER
About

Brightness

Menu

=
.

Brightness 5

/| Activate 'IPCScreenSaver' screen saver

|_| Screen saver transparent, desktop visible
|:| Wake up with 100% brightness

2. Select "Activate 'lPCScreenSaver' screen saver".

3. Open the "Screen Saver Settings".

—i

Screen Saver |

Screen saver

|pcscreensaver v]

Wait: 1
Power management

brightness and other power settings.

Change power settings

= - !
= minutes [] On resume, display logon screen

Conserve energy or maximize performance by adjusting display

Settings... Preview

4. Under "Screen saver", select the "Ipcscreensaver" screen saver.

SIMATIC IPC Wizard 2.1 and Panel Configuration Center
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Software description

3.1 General for all devices

5. Click on the "Settings" button. The "Ipcscreensaver" dialog box opens.
6. Set the waiting time until a screen saver switches on.

7. Make additional settings as needed. Close all open dialogs.

Note
No screen saver

If you select "Ipcscreensaver"” as the screen saver and disable it in step 2, no other
screen saver is activated. The device has no screen saver until you either activate the
"Ipcscreensaver" again or select another screensaver from the Windows screen saver
settings.

8. Set the desired "Brightness" for the connected devices using the slider or the "-" and "+"
buttons.

If you set the value "0%" as the "Brightness", the backlighting of the display is disabled.

9. If needed, select "Screen saver transparent, desktop visible". The screen saver generates
by default a black full screen window on each screen. With the "Screen saver
transparent, desktop visible" option, the window is transparent and the static screen of
the desktop is visible.

10.1f needed, select "Wake up with 100% brightness". After switching off the screen saver,
the screens of all connected devices are operated with 100% brightness.

SIMATIC IPC Wizard 2.1 and Panel Configuration Center
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Software description

3.2 Special for devices with resistive single touch screen

3.2

3.2.1

3.21.1

22

Special for devices with resistive single touch screen

Universal Pointing Device Driver (UPDD)

Overview UPDD Console

The Universal Pointing Device Driver (UPDD) offers the following functions for single-touch
operator panels:

® Configure clone mode with several operator panels, including touch interlock
® Configure extended mouse functions

® Configure properties for operating the touch screen

e (Calibrate the touch screen and check the calibration

® Display the status of the operator panel

This chapter describes the following typical applications:

® |Calibrate touch screen|(Page 24)

e Deactivate touch functionality (Page 27)

® |Activated extended touch functions (Page|28)

® |Touch in Extended Monitor Mode (Page|28)

For the meaning of all UPDD parameters, refer to the Online Help.

UPDD Console

The UPDD Console is used to configure the UPDD driver:

1. Open the PCC and go to the "UPDD Settings" tab.

2. Click on the "Settings" button. The UPDD Console dialog box opens.

SIMATIC IPC Wizard 2.1 and Panel Configuration Center
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The "Hardware" tab shows the touch controllers of devices detected by the UPDD driver.

Ho. Smartset{4) ()

Select device [x
E Ho. Smartset
& Bo. Smartset(4)

< - B Connected to USB port

E Calibration

Status

l:l'}ﬂ Add a new device

== Remove this device

Calibrate  Close 2) help 7 About

If you remove one of the devices recognized by the UPPD driver, the associated touch
controller is marked red.

In the following example the connection to the device with the "Elo.Smartset(4)" touch
controller was removed.

Select device
@ Ho. Smartset
@ Ho. Smartset(4)

) Connected to USB port

l:l']i Add a new device

Remove this device

If you reconnect the device with the "Elo.Smartset(4)" touch controller, the "Elo.Smartset(4)"
entry is highlighted in black again.

SIMATIC IPC Wizard 2.1 and Panel Configuration Center
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If you no longer need the device with the "Elo.Smartset(4)" touch controller, you can select
the touch driver and remove it by using the "Remove this device" button.

Note
Removing disconnected devices from the list

To ensure proper functioning of the UPDD driver, remove the touch controllers of all devices
that are not connected from the touch controller list.

3.2.1.2 Notes on clone mode
In clone mode, all screens of the connected devices show the same content.

The touch screen is secured by means of an interlocking mechanism. When a device is
being operated, the operation of any other devices is blocked for a certain time. This means
it is not possible to execute an operator action simultaneously on multiple operator panels.

Procedure
1. Open the "UPDD Console" dialog.
2. Select "Properties > Interlock".

3. Enter the value> 0 for the "Timeout".

Disabling the interlock

To disable the interlock, set the the value "0" for the "Timeout".

3213 Calibrate touch screen

Calibrating the touch screen

The touch screen of the device is pre-calibrated (3-point calibration) in the delivery state. The
following two calibration types are available to recalibrate the touch screen:

e Standard 3-point calibration:
The calibration data are stored in the EEPROM on the device.

e Advanced calibration with up to 25 calibration points, recommended if there are special
requirements for accuracy:

The calibration data are stored in the registry of the operating system on the PC.

SIMATIC IPC Wizard 2.1 and Panel Configuration Center
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Standard calibration

Procedure
1. Open the "UPDD Console" dialog.

2. Select the touch controller of the device you want to calibrate in the header of the dialog.

@Haduae Style Normal

@ Click Mode HF Add a new style

E Calibration Mumber of points
E R

g Margin % m Use eeprom storage
1 * 3

["] Confirm after calibration
Timeout (secs)

2 4 @ @ Sound Options

1] calibrate  Close

™~
i
]

3. Click the "Calibration" tab.

4. Activate the option "Use eeprom storage". For Touch Controllers with EEPROM, the
option box is pre-selected.

The option box "Number of points" shows "3-point calibration”.

5. Click the button "Calibrate".
The calibration screen is displayed in the selected display.

6. Quickly touch the corresponding selections one after the other.
The entry is confirmed by a check mark, the next selection is displayed.

7. Confirm all input prompts (arrows, or crosses in the center) until the complete screen has
been calibrated.

Note

If the screen does not respond to touch as expected, check the controller selected under
"1." in "UPDD Console" and repeat the calibration. Only an active touch controller can be
calibrated. A removed touch controller is displayed in red.

If the accuracy of this 3-point calibration is not sufficient, you can clear the "Use eeprom
storage" option box and use the extended 25-point calibration instead.

SIMATIC IPC Wizard 2.1 and Panel Configuration Center
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Extended calibration
Procedure

1. Open the "UPDD Console" dialog.

2. Select the touch controller of the device you want to calibrate in the header of the dialog.

@Haduae Style Normal

@ Click Mode HF Add a new style

E Calibration Mumber of points
25 P <4

g Margin % D Use eeprom storage
1 L

["] Confirm after calibration
Timeout (secs)

2 4 @ @ Sound Options

Calibrate f Close 2) Help 7 About

Click the "Calibration" tab.
Deactivate the option "Use eeprom storage".
Enter the value "25" under "Number of points".

Click the button "Calibrate".
The calibration screen is displayed in the selected display.

o o & w

7. Touch the corresponding selections one after the other.
The entry is confirmed by a check mark, the next selection is displayed.

8. Confirm all input prompts (arrows, or crosses in the center) until the complete screen has
been calibrated.

9. Finally, press "Confirm" for the input prompt.

SIMATIC IPC Wizard 2.1 and Panel Configuration Center
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3.2.1.4 Touch functionality
Deactivate touch functionality
Procedure

1. Open the "UPDD Console" dialog.

2. In the header of the dialog, select the touch controller you want to deactivate.

Name J Elo, Smartset

Lmlpassﬁller]} + EUseliﬂ-oﬂ

Liftoff time [0 S [[] Ancher mouse
Stabilization [0 L [ Enabiea
Averaging JD d’

3. Select the "Properties" tab.
4. Deactivate the "Enabled" option.

The controller is deactivated.

Note
If you close the dialog box using "Close", the touch functionality remains deactivated.

If you have not connected a mouse, you can also reactivate the touch panel by means of
a keyboard entry. Restart the "UPDD Console" via the start menu.

The keyboard entry <Alt+p> opens the "Properties" tab. Then the touch panel can be
reactivated by entering <Alt+n>. (Option button "Enabled")

SIMATIC IPC Wizard 2.1 and Panel Configuration Center
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Extended Touch touch functionality

Procedure

1. Open the "UPDD Console" dialog.

2. Select the touch controller of the device you want to activate the extended touch
functions for in the header of the dialog.

3. Select the "Click Mode" option.
4. Activate the option "Extended Touch".

Note

"Extended touch" is only available for the Windows 7 Ultimate and WES7P operating
systems.

If "Extended touch" is activated, the extended touch functions of Windows 7 are also
available, such as permanently touching the touch screen, which corresponds to the right
mouse button function. In addition, a virtual "OnScreenKeyboard (OSK)" is automatically
opened for the Windows logon and when input boxes are activated.

Touch in Extended Monitor mode

In Extended Monitor mode you can operate a PC with several touch devices.

Requirement

e All touch devices are connected to the PC.

SIMATIC IPC Wizard 2.1 and Panel Configuration Center
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Procedure

In the following description for setting up Extended Monitor mode, one touch device is set up
in portrait format and one touch device in landscape format. The description can also be
applied for two touch devices in landscape format.

1. Open the Windows display settings using one of the following methods:
— Select "Start > Control Panel > Display > Change display settings"
— Right-click on the desktop. Select "Screen resolution" from the shortcut menu.

— Select "Start > Run", enter "desk.cpl" and confirm the input with <RETURN>.

[£] screen Resolution = IDIiI
o N Ters -
‘\ )\_) |i w Display v Screen R... - [‘g‘l Search Control ... H

Change the appearance of your displays
1920,0 Detect |
ldentlfy
Display: |1. IFP 1900 TEX 'I
Resolution: ITG& % 1366 (recommended) EI
Orientation: |Dnrtra'rt(f|ippedl 'I
Multiple displays: IEx'tend these displays EI
[~ Make this my main display Advanced settings
Connect to a projector (or press the & key and tap P)
Make text and other items larger or smaller
What display settings should I choose?
Ok | Concel | Appy | :l

2. Set the resolution and orientation of the connected touch devices:
— Select a screen resolution under "Resolution”.
— In the "Orientation" input box, select the entry "Landscape" or "Portrait (flipped)".

3. Close the dialog with the "OK" button.

SIMATIC IPC Wizard 2.1 and Panel Configuration Center
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30

4. Open the "UPDD Console" dialog.

@ R (3 Handiing Whole desktop

) Connected to USB port

l:l']:l Add a new device

== Remove this device

Calibrate  Close 2) help 7 About

5. Click the "Hardware" tab.
6. Click "Handling Whole desktop".

The "Desktop Area" dialog box opens.

Ho. Smartset(4)

Select a monitor or desktop area from the list below

Whole @ & Configure All...

A calibration may be required if this setting is changed

7. Click "Configure All...".

You are prompted to touch the touch screens of the connected touch devices one after
the other.

When you are finished, the UPDD driver includes the assignment of the monitors to the
corresponding touch screens.

8. Calibrate the touch screens of the touch devices one after the other. All touch devices

must be calibrated with an extended calibration of at least 9 points. A description of the
calibration procedure is available in chapter "Extended calibration |(Page 26)".

SIMATIC IPC Wizard 2.1 and Panel Configuration Center
Operating Manual, 07/2014, ASE34984843-AA



Software description
3.3 Special for devices with capacitive multi-fouch screen

3.3 Special for devices with capacitive multi-touch screen
3.3.1 Interlock in clone mode
3.3.1.1 Notes on clone mode

In clone mode, all screens of the connected devices show the same content.

The touch screen is secured by means of an interlocking mechanism. When a device is
being operated, the operation of any other devices is blocked for a certain time. This means
it is not possible to execute an operator action simultaneously on multiple operator panels.

3.3.1.2 Activating the interlock mechanism

Introduction
The interlock mechanism in clone mode prevents simultaneous operation of two devices.

If you have two or more touch screens, which are operated spatially separate from one
another, two operators can use the same application simultaneously. You use the interlock
to prevent reversing an input on device 1 by a second input on device 2: When a device is
being operated, the operation of any other devices is blocked for a certain time.

The time until the device is released is reset with each new touch input. There is no visual
feedback for which panels are locked and which panel is being operated. The touch devices
are controlled in the background by the "HidLock.exe" application, so that the PCC does not
have to be open for the function to be available.

If you remove a connected device from the PC while it is locked, it releases as soon as you
connect it to the PC again. The interlock of a device is a setting in the non-permanent,
volatile memory and therefore is only effective during operation.

Procedure
1. Open the PCC and go to the "Interlock" tab.
2. Activate "Activate interlock".
3. Specify the "Interlock time", for example, timeout 10 seconds.

As soon as operation is performed on a device, operation of the other device is blocked
for 10 seconds. An input or touch of the screen then has no effect for 10 seconds.

SIMATIC IPC Wizard 2.1 and Panel Configuration Center
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3.3.2 SIMATIC Switch Touch Mode

3.3.21 Overview

You operate a device a with a capacitive multi-touch screen using up to five fingers. In doing
so, the device recognizes gestures such as swiping, zooming, and rotating. The WES7E
operating system is not supported.

The SIMATIC Switch Touch Mode tool changes the touch controller of a connected multi-
touch device (five fingers, gestures) over to single-touch mode. In single-touch mode, the
device behaves like a single-touch device that you operate with a single finger only and
without gestures.

After the changeover, you can operate your multi-touch device with the WES7E operating
system.

Differences and limitations in single-touch mode

® Opening the shortcut menu: In order to open the shortcut menu in single-touch mode,
follow these steps:

Tap and hold a position 1 and briefly tap on any position 2 while doing so.
e Avirtual keyboard is displayed for logon.
® Changeover Multi-touch / single-touch mode in "Landscape" orientation.

® Only one device can be operated in extended monitor mode. The other devices are not
recognized by the touch controller. Therefore, operate multiple devices in clone mode.

SIMATIC IPC Wizard 2.1 and Panel Configuration Center
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3.3.2.2 Toggling Switch Touch Mode

Device detection

All detected devices are displayed in a list in the PCC with the "Touch settings" tab. In
addition to the device name, the touch mode of a device is shown: Multi-touch mode or
single-touch mode.

PANEL CONFIGURATION CENTER
Menu About

Brightness For the first assignment in Extended Monitor mode,
Tablet PC touch the touch screens one after the other
settings (display 1, 2, ...), see "Setup" in the dialog on the

right.
eI Found the following devices with capacitive multi-touch screen:
Device 1 (FWV 6.20)in Single touch mode SWITCH MODE
Touch settings
Device 2 (FWV 6. 20 ) in Single touch mode SWITCH MODE

Toggles the display orientation of all devices connected: Portrait
or landscape format.

Procedure

1. To determine which entry in the list belongs to a given device, operate the connected
devices one by any with a touch input. The corresponding entry for the action is
highlighted in blue in the list for a short time.

2. To change the touch mode for a device, click on the respective "Switch Mode" button.
The touch mode of the device displayed next to the button changes.

Toggling in single-touch mode

The device is in single-touch mode. Check: If you draw a rectangle on the touch screen with
your finger, you will see an arrow — the typical mouse pointer — under your finger.

Toggling in multi-touch mode
In order to change back to multi-touch mode, follow these steps:
1. Click on the "Switch Mode" button.

The device is in multi-touch mode. Check: If you draw a rectangle on the touch screen with
your finger, you will see a small dot under your finger.

SIMATIC IPC Wizard 2.1 and Panel Configuration Center
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Removal

3.4

3.4.1

3.4.1.1

34

Note

If the device is left in single-touch mode, you can no longer use the device in multi-touch
mode after removal. In order to reactivate multi-touch mode in this case, SIMATIC IPC
Wizard must be installed again.

Therefore, switch back to multi-touch mode before uninstalling the SIMATIC IPC Wizard (see
above).

Special touch/key devices

KeyToolsPhone

Overview

SIMATIC IPC KeyTools_Phone offers the following functions for key devices:
® Configure keyboard layout properties for operating the keys
® Configure clone mode with multiple operator panels, including key interlock
® Configure extended functions in clone mode, for example:
— Set a minimum time between two key operations
— Display the status of the operator panel
o KeyTools status display
Summary of KeyTools information
® Configure keycode table
Load and edit keycode tables
® Configure security features
Activate and deactivate safety-related settings
e Control LEDs

Control of LEDs using the "LedControl" tool for front panels that have function keys with
LEDs

Note
Front panel keyboard

The term "front panel keyboard" used in the following applies only for keyboards on the
operator panels.

Selecting the language

To display all pre-programmed characters correctly, the input language and language
properties in Windows must be set to "United States-International”. See section Language
selection for key devices|(Page 54).

SIMATIC IPC Wizard 2.1 and Panel Configuration Center
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3.4.1.2 Clone mode

Notes on clone mode
In clone mode, all screens of the connected devices show the same content.

The touch screen is secured by means of an interlocking mechanism. When a device is
being operated, the operation of any other devices is blocked for a certain time. This means
it is not possible to execute an operator action simultaneously on multiple operator panels.

Note
Maximum of two key devices in clone mode

A maximum of two key devices can be operated simultaneously in clone mode.
Malfunction due to incorrect mapping of the keyboard

If you connect two key devices with different key layouts to an industrial PC, incorrect
mapping of the key layout table can result in malfunctions. This may damage the machine or
plant.

Connect only keys devices with the same key layout.

Disabling the interlock

To disable the interlock, set the the value "0" for the "Timeout".

Note on 15" touch/key device

Requirements
e A SIMATIC Industrial Flat panel is connected to at least one PC.
® Close mode is enabled.

e A 15" touch/key device is connected

NOTICE

Security gaps in clone mode

Under the requirement described above, a password entry on the second screen is
displayed in plain text with letters and not hidden by asterisk *. Confidential entries such as
passwords can be read and misused. The security of the machine or plant is threatened.
Protect confidential data from unauthorized access:

¢ Disable the preview window, for example, for the PhoneKeyPad (see "Special for
touch/key devices").

e Use a USB keyboard.
¢ Switch off the second screen.
¢ Reduce the brightness of the second screen.

SIMATIC IPC Wizard 2.1 and Panel Configuration Center
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Interlock mechanism in clone mode

Function of the interlock mechanism

The interlock mechanism in clone mode prevents simultaneous operation of two devices.
A timeout defines how long the unoperated device is locked.

The timeout is set in a registry key, see section Setting the timeout|(Page 36).

Type of interlocking Brief description

Timer mode "Timer mode" is always active.

The timeout in timer mode is assigned to an device as soon as operator
input occurs. As long as the timeout has not expired, no input is permitted

on another device.

Configuring the timeout

The duration of the interlock (timeout) defines how long the non-operated device is locked.
The timeout is stored in a registry key in the Windows registry.

This data is read in at system startup and used as start values for the driver.

The respective procedure is described in the following sections.

Setting the timeout

Defining the runtime for timeout after keystroke
This variable defines the value of the runtime in milliseconds.

The variable is a DWORD. The interface to the driver can only process positive values. The
runtime is entered into the registry as a hexadecimal value.

During the driver installation at system startup, this variable is automatically created in the
registry by the INF files (default is 3000 ms = Obb8 hexadecimal).

Path

[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\filter]
"TimeOut"=dword:00000bb8

Visualization interfaces to other applications

36

On the application level, data can be read or sent from the driver. An application that
implements the corresponding driver interfaces is required for this purpose. Access by the
application is possible via three user interfaces in the USB keyboard controller driver
(package version 2.4 or higher). These interfaces with examples for access in C++ are
described in the following sections.

The interfaces are IOCTL commands. The calls are executed as functions in the driver to
change the status of the driver.

SIMATIC IPC Wizard 2.1 and Panel Configuration Center
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Updating the timeout value

If this command is called, the timeout value is read for the driver from the registry during
runtime. The updated value is then returned.

Calling the command in C++

You access the command as follows in C++:

#define IOCTL ADMIN TIMEOUT READ REG CTL CODE (FILE DEVICE UNKNOWN,
0x805, METHOD BUFFERED, FILE ANY ACCESS) //GTA update the TimeOut
value from the registry

HANDLE hdevice = CreateFile ("\\\\?\\KeyHookFilter", GENERIC READ |
GENERIC WRITE, 0, NULL, OPEN EXISTING, 0, NULL);

if (hdevice == INVALID HANDLE VALUE)
{
AfxMessageBox (" INVALID HANDLE VALUE - KeyHookFilter - Not
found! ");
}
else

{

DWORD junk;

volatile DWORD Admin MODE Status; //volatile DWORD
KeyHookFilterStatus;

TimeOut = 0;

if ( DeviceIoControl (hdevice, IOCTL ADMIN MODE STATUS, NULL, O,
(PVOID) & TimeOut, sizeof (Admin MODE Status), &junk, NULL))
{

AfxMessageBox ("TimeOut update is: %d", TimeOut);

}

CloseHandle (hdevice) ;

}

SIMATIC IPC Wizard 2.1 and Panel Configuration Center
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3.4.1.3 Operating the KeyToolsPhone

Procedure

1.

Open the SIMATIC IPC KeyTools with "Start > All Programs > Siemens Automation >
Panel Configuration Center > KeyToolsPhone > IPC KeyToolsPhone".

I_-SIMATIC[_PC ——

File ?
Statuz -
TACO Version: 4,05
F.ey table:
Security enabled: OM

WinCC hotkey enabled:  OFF

- Keycode table

Security features -
¥ Securty enablad

[ WinCLC hatkey enabled

Bestore Key Phone default settings I

ak Apply | Lancel ‘

e

Use the "Restore Key_Phone default settings" button to restore the key assignment to the
factory state.

Use the "OK" button to exit the program and apply the changes made to the KeyTools
setting.

Use the "Cancel" button to exit KeyTools. The changes are not applied.

5. Use the "Apply" button to apply changes made to the KeyTools setting.

38
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"Status" area

When the program is called for the first time, no value is displayed for "Key table" in the
"Status" area. Values are only displayed after a keyboard table is loaded.

Status
TACO Version: 4.05
F.en table;
Security enabled: oM

WwinCC hotkey enabled:  OFF

Status Information display

Controller version Release version of USB keyboard controller
Key table Last file loaded for the USB keyboard controller
Security enabled Activation status of security settings

WinCC hotkey enabled Activation status of "WinCC hotkey" function

"Keycode table" area

Select one of the options in the "Keycode table" area.

F.epcode table

& |PC PhoneKey Panel_15"wide - [F1-F3F)

" IPC PhoneKeyp Panel_15"wide - [F1-F12)

" User specific |

"IPC PhoneKey Panel_15"wide — (F1 — F36)" option

When you select "IPC PhoneKey Panel_15"wide — (F1 — F36", a pre-defined default keycode
table is loaded. This key assignment corresponds to the factory state.

Keys Keycode

F1to F12 F1to F12

F13 to F24 Shift + F1 to Shift + F12
F25 to F36 Ctrl + F1 to Ctrl + F8
Alphanumeric, cursor and control keys USA international

SIMATIC IPC Wizard 2.1 and Panel Configuration Center
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The default settings of the function keys <F13 to F20> correspond to the specifications
required for using the keys, for example in the SIMATIC HMI software.

Note

The security features are activated — see section:
e "Status" area (Page 39)

e "Security features" area (Page|45)

Procedure

To send the keycode table to the keys of the key device, follow these steps:
1. Activate "Send table".

2. Select the option "IPC PhoneKey Panel_15"wide — (F1 — F36)".

3. Click on "Apply" or "OK" to confirm.

The keycode table is sent. The sent keycodes are activated immediately.

The keycode table cannot be changed.

"IPC PhoneKey Panel_15"wide — (F1 — F12)" option

When you select "IPC PhoneKey Panel_15"wide — (F1 - F12", a PC-compatible keycode
table is loaded. The following applies:

e The function keys F1 to F12 correspond to the mapping of a PC keyboard

® Function keys F13 to F36 are not used.

Option "User specific"
Select the "User specific" option to:
® | oad a custom keycode table and assign the keys of a key device

e Edit the key mapping

SIMATIC IPC Wizard 2.1 and Panel Configuration Center
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Load a custom keycode table and assign the keys

1. Activate "Send table > User specific".

Open KeyPad
Key table

K.ey table:
Secuty enabled:

WinCC hotkey enabled:

~ kepcode table

™ |PC Phonekey Panel_15"wide - [F1-F36)

™ |PC Phonekey Panel_15"wide - [F1-F12)

@ User specific | Browsze... '

— Security features

¥ Security enabled

[ WinCC hotkey enabled

Bestore Key Phone default gettings J

Apply ] Cancel ]

2. Press the "Browse" button or select the menu command "File > Key table"

SIMATIC IPC Wizard 2.1 and Panel Configuration Center
Operating Manual, 07/2014, ASE34984843-AA

41



Software description

3.4 Special fouch/key devices

The "Open" dialog box is displayed.

Organize = MNew folder = » [ @ "
S Favoriies = Name Date modified Type
Bl Desktop || tabl5w.pad 2/15/2012 2:44 PM PAD File
4 Downloads || tabl5w_st.pad 3/21/2012 3:43 PM PAD File

Tr=1
- |
= Recent Places

- Libraries y
@ Documents
J’ Music
[=] Pictures
B videos

m

8 Computer

“ﬂ Network bl LLL} | ¢
File name: Y ~ | KeyPad Files (*.pad) -

| Open | | cCancel |

The "C:\Program Files\Siemens\Automation\PanelConfigurationCenter\PhoneKeyPad"
directory contains the following files for a 15" widescreen key device:

— The file "tab15w.pad" with the keycodes "Default Panel PC"
— The file "tab15w_st.pad" with the keycodes "Standard PC compatible"
3. Select the desired file and click "Open".

4. Select "Apply" to assign the selected keycode table to the keys of the key device or
"Cancel" to abort.

SIMATIC IPC Wizard 2.1 and Panel Configuration Center
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Editing the key mapping

If you load a custom keycode table and assigned to the keys of the key device, you can edit
the key mapping of the F keys using the KeyPad.

1. Activate "Send table > User specific".

Open KeyPad

Key tabl
diwag 05

Key table:
Security enabled: oM
"WinCC hotkey enabled:  OFF
~ Keycode table-
¥ Send table:
i |PC Phonekey Panel_15"wide - [F1-F3E)

7 |PC Phonekey Panel 15"wide - [F1-F12)
& |lzer specific | Browse.. |

— Security features

¥ Securty enabled

[~ WinCC hotkey enabled

Restore Key Phone default gettings J

QK | Apply | Cancel 1

2. Select "File > Open KeyPad".
The KeyPad opens.

SIMATIC IPC Wizard 2.1 and Panel Configuration Center
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B t=bi5wpad - Key
File Wiew 7

DedE =7

L

=

o

Table N Alpha key : | Not exist ']

Send table to TACO:  Send!

_,_‘
)
1
L
=@
&

Comment:

=
~

-
w

Test:

=
@

=
o
s

R

=

o I

F13

F1&

F16

ALK

ENTER

F17 F18

F27 F28

Ready

F21 F22 F23

el Faz F33

F25 F26

F35 F3E Iz‘

[« [»]

[v]
ol

[Num |

3. Open the assignment of an F key with a mouse click use the "Enter" key.
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The "Key definition" dialog box opens.

Key definiticn

MHumber of key 135

MHame of key : ]F1

Hormal Mode

¥ Enable  USE scan code: DHiSa [Hex]  Mame: IF1

[ LShitt [~ LCwl
[ RShitt [~ RCHl

[T LAk [ Lwin
7 Ralt [~ Rwin

|

— In"Normal mode", define which keycode is to be sent.

— The options allow you to specify which keycode is assigned in addition to the keycode

under "Name".
Example:
Name Option Display/function
F1 - F1
F1 LCtrl F1 + Ctrl

"

The section "Keycode table (Page|54)" contains a list of all names which can be selected
in the "Name" group. The "Display/function" column lists the display or function which is
triggered when the respective button is clicked.
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4. Pressing the "Send!" button assigns the complete, edited keycode table to the keys.

The changes take effect immediately.

Note

The "Send!" button is only enabled if the application has been started on a key device.
The keyboard layout is English (USA international). Please note that the layout of an
external keyboard must correspond to the international character set. This layout
guarantees that the characters on the keys agree with the characters on the screen.

You can use the "IPC Keyview" program to view the keycodes of pressed keys.

Open the "IPC Keyview" with "C:\Program Files\Siemens\Automation\
PanelConfigurationCenter\KeyTools\Keyview\KeyView.exe" or via the Start menu.

As soon as you press a key, the corresponding codes appear in the "IPC Keyview" window.

Char Repeat Scan Ext
Bx 80861 1 Ho
Ho
Ho
Ho
Ho
Ho
Ho
Ho
Ho
Ho
Ho
Ho

8z 8862
8x8063

8x 0864
- 68
WH_SYSKEYDOWN 18

1
1
1
1
1
1
1
1
1
1
1

"Security features" area

Function "Security enabled"
With the "Security enabled" option, the F keys of a key device are interlocked.

The "Security features" are always activated in the factory state of a SIMATIC IPC.

A\ warRninG

Personal injury or property damage can result from malfunctions due to lacking key
interlock

For security reasons it is recommendable to always use the "Security features" and not to
deactivate them.

If "Security features" is nevertheless deactivated by the user, it must be guaranteed that no
malfunctions can be triggered in the application program.

Clone mode is only permitted if the "Security features" are activated.

The interlocking mechanism is inactive during deactivation.

SIMATIC IPC Wizard 2.1 and Panel Configuration Center
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Security features
¥ Security enabled

[~ WinCC hatkey enabled

46

If you activate "Security enabled", the "Security features" are effective immediately. You
do not need to restart the device.

If you deactivate "Security enabled", the "Security features" become ineffective
immediately.

INFO MESSAGE - Security enabled ) x|

Warning !
ﬂ
L

The deactivation of the security Features may cause severe malfunctions
when using the funkkionkeys or softkeys,
For additional informations seleck the Menu - Help and read the document.

I take naote of this document,

abbrechen

A\ warRninG

Personal injury or property damage can result from malfunctions due to lacking key
interlock

If you deactivate "Security features", significant malfunctions may occur in the user
software when using function keys <F13 to F36> or when using custom keycode tables.
The keycodes associated with the function keys can also be triggered by keys other
than the configured ones.

The following is generally applicable:
Malfunctions can also be triggered by external input devices or combinations of external
input devices and key devices. The "Security features" are ineffective in such cases.

When using function keys within WinCC (TIA Portal), a reaction in the automation
process is directly assigned to individual keys by the configuration settings.

To guarantee safe operation of the automation process, make sure that only the
configured key triggers the desired reaction.

If the same keycode can be sent using other function keys, so-called "ghost keys" then
exist. This must be prevented.

Triggering of "ghost keys" from the front panel keyboard is prevented by the activated
"Security features".

SIMATIC IPC Wizard 2.1 and Panel Configuration Center
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Principle of operation of the "Security features"

If one of the "Default Panel PC" keycode tables is loaded, the following strings are sent by
the keyboard controller of the front panel keyboard when an <F> key is pressed:

Key pressed Keycode string sent
F1to F12 F (1to 12)

F13 to F24 Shift + F(1 to 12)
F25 to F36 Ctrl + F(1 to 12)

The <F1 to F12> keys of the front panel keyboard send the same keycodes as an external
USB or PS/2 keyboard. An extension of the keycode string has been defined for the
remaining 24 <F> keys because only a limited number of keycodes is made available by the
operating system. These <F> keys are defined by the keycode string <Shift> or

<Ctrl+F(1 to 12)>.

If the <Shift> and <Ctrl> keys as well as the <F> keys are pressed simultaneously, "ghost
keys" may be triggered in the customer application as a result of the combination of keycode
strings. Examples are listed in the following table.

Key 1 Key 2 Desired key Activated key

Shift (Shift) F1 (F1) Shift and F1 F13 (Shift, F1)

Ctrl (Ctrl) F1 (F1) Ctrl and F1 F25 (Ctrl, F1)

F14 (Shift, F2) F1 (F1) F14 and F1 F14 (Shift, F2)
F13 (Shift, F1)

Key 1 and key 2 are pressed simultaneously. The desired key and the actually activated key
are displayed ("Security features" are deactivated). The sent keycode string is shown in
parentheses.

Simultaneous pressing of two <F> keys, as well as combination of the <Shift> or <Ctrl> key
with an <F> key is therefore blocked by the "Security features" in the factory state.

The following checks must be made in this case:

® (Can an undesired function be triggered by simultaneously pressing the <Shift> key and
an <F> key?

® Can an undesired function be triggered by simultaneously pressing the <Ctrl> key and an
<F> key?

® (Can an undesired function be triggered by simultaneously pressing two <F> keys?
Functions triggered by mistake can be avoided by:
® Changing the keycode table by editing using "Keycode table > User specific > Edit"

® Changing the user application

SIMATIC IPC Wizard 2.1 and Panel Configuration Center
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Example

Two functions are defined in the customer application, where the following prerequisites
apply:

e "Security features" are deactivated and the "IPC PhoneKey Panel_15"wide — (F1 — F36)"
keycode table is loaded.

® The desired function "X" is triggered by simultaneously pressing the <Shift> and <F1>
keys.

® The function "Y" is triggered by pressing the <F13> key.

Note

The following keycode sequences exist for <Shift + F1> and <F13>. The customer
application cannot distinguish which keys have been pressed. The result is an undefined
reaction of the customer application:

e The function "Y" can be triggered by pressing the two keys <Shift+ F1>.
e The function "X" can be triggered when pressing the <F13> key.

Solution
Approach 1:

The keycode table is modified using "User specific > Edit" such that a different keycode
string is sent when pressing the function key <F13>, e.g. <ALT + F1>. The customer
application must be able to appropriately evaluate this new keycode string.

Approach 2:

The customer application is modified such that the function "Y" is not assigned to function
key <F13> but e.g. to <F12>. The function keys <F1> and <F12> have different keycodes in
the keycode table "IPC PhoneKey Panel_15"wide — (F1 — F36)".

Function "WinCC hotkey"

Security features
v Security enabled

¥ WinCC hotkey enabled

Certain programs, for example, WinCC (TIA Portal), interpret the sequence of keycodes sent
over the keyboard interface in their own manner. The function "WinCC hotkey" permits
adaptation to this response.

SIMATIC IPC Wizard 2.1 and Panel Configuration Center
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Example

If you activate "WinCC hotkey enabled", the keycode for "Releasing a function key" is sent in
the exchanged keycode string expected from WinCC (TIA Portal).

The following tables list the keycode strings sent with the "WinCC hotkey" function activated
or deactivated:

e Keycode string with function "WinCC hotkey" deactivated:

Function keys Press key Release key
F1to F12: F (1to12) F (1to12)

F13 to F24: Shift, F(1 to 12) Shift, F(1 to 12)
F25 to F36 Ctrl, F(1 to 12) Ctrl, F(1 to 12)

e Keycode string with function "WinCC hotkey" activated:

Function keys Press key Release key
F1toF12: F (1t012) F (1t012)

F13 to F24: Shift, F(1 to 12) F(1 to 12), Shift
F25 to F36: Ctrl, F(1 to 12) F(1to 12), Ctrl

If "WIinCC hotkey enabled" is activated, the "WinCC hotkey" function is automatically started
when booting the Panel PC.

Controlling LEDs of the key devices

The LEDs are controlled using the command shell application "LEDControl" with the
following functions.

® Switch off LED
® Switch on LED
e Flash LED

® Query current status of LED

See also

Parameter (Page|51)

SIMATIC IPC Wizard 2.1 and Panel Configuration Center
Operating Manual, 07/2014, ASE34984843-AA 49



Software description
3.4 Special fouch/key devices

Command shell application "LEDControl"

Procedure for actuating the LEDs
1. Open the command shell application with "Start > Run > cmd".
2. Confirm with "OK."
3. The shell command prompt is displayed.
4. Enter the command "LEDControl" and confirm the entry.
The command shell dialog box is opened.
Access: LEDControl [set ] [number] [status]

Example:

WWINDOWS system32 . cmd.exe

LEDCONTROL [=et] [number] [statusl

[zet] numbher of the LED set <@ - 2)
[number] numbher of the LED in the set (B — 16<{7 for set '2"2>
("@" is only valid for switching a status)
[status] target status of the LED(s> (B = OFF, 1 = OM, 2 = blinking>

LEDCONTROL zet number status
—» switch a LED <or the whole LED set if number = B> to a target state

LEDCONTROL zet number
returns the status of a LED (8 — 1 in errorlevel’

-
LEDCONTROL =et

- returns the status of a LED set (16 hit binary in errorlevel’
values in the errorlevel above BxFFFF are errorcodes

Errorcode : Bx20003

The application is defined by the parameters "Set", "Number" and "Status".

"Set" and "Number"

Set Number
0 0to 16
1 0to 16
2 Oto7

The buttons are grouped in "Sets". For the assignment, see section "Parameters /(Page|51)".

The "Number" parameter stands for the actuation of the LEDs. "Number" 0 stands for the
entire set; 1...16 or 1...7 control individual LEDs.

"Status"
e (=off
e 1=on
e 2 =flashing

SIMATIC IPC Wizard 2.1 and Panel Configuration Center
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Error codes
If an error in the program occurs, an error code is output.
The variable %errorlevel% represents the return value from the program.
Description Outputs on the screen Output variable %errorlevel%
Driver error 0x20001 131073
Program errors 0x20002 131074
Invalid parameter 0x20003 131075
Parameter
Note
The variable "%errorlevel%" represents the value that is returned by the "LEDControl"
program.
LED designation of LED off LED on LED flashing Comments
keys set/number/status | set/number/status | set/number/status
F4; F9..F12; F14; 000 001 002 Set 16 bit /
F17..F19; F23..F26; Decimal 65535 (-1)
F27.F29 (Set 0)
F1...F3; F5..F8; F13; 100 101 102 Set 16 bit /
F20..F22; F33..F36; Decimal 65535 (-1)
alA (Set 1)
HELP; ACK; F15; 200 201 202 Set 8 bit /
F16; F30..F32 Decimal 127
(Set 2)
F1 110 111 112
F2 160 161 162
F3 130 131 132
F4 0160 0161 0162
F5 180 181 182
F6 140 141 142
F7 150 151 152
F8 120 121 122
F9 020 021 022
F10 0130 0131 0132
F11 040 041 042
F12 0150 0151 0152
F13 170 171 172
F14 0120 0121 0122
F15 210 211 212
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LED designation of LED off LED on LED flashing Comments
keys set/number/status | set/number/status | set/number/status
F16 220 221 222
F17 060 061 062
F18 010 011 012
F19 030 031 032
F20 1150 1151 1152
F21 1140 1141 1142
F22 1160 1161 1162
F23 0110 0111 0112
F24 090 091 092
F25 0140 0141 0142
F26 0100 0101 0102
F27 070 071 072
F28 050 051 052
F29 080 081 082
F30 250 251 252
F31 270 271 272
F32 260 261 262
F33 1100 1101 1102
F34 190 191 192
F35 1120 1121 1122
F36 1130 1131 1132
HELP 240 241 242
ACK 230 231 232

Examples

Example: Switch on LED "S16"
#> LEDControl 2 2 1

Parameter Explanation of the parameters
2 [set] The LED is in set 2.

2 [number] The LED number 2 is set.

1 [status] The LED is switched on.
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Example: Query status of LED "S16"
#> LEDControl 2 2

Parameter Explanation of the parameters

2 [set] The LED is in set 2.

2 [number] The LED number 2 is set.

Status The status is output in %errorlevel% and displayed as 1.
Note

If the LED flashes a current status cannot be correctly returned. Only the "LED switched on"
status can be queries.

Example: Query status of an LED set (16 LEDs)
#> LEDControl 2

Parameter Explanation of the parameters
2 [set] The LED set 2 is queried.
Status The status is output in %errorlevel%. The value is between 0 and 65535.

Assumption: "F15" and "F16" are switched on. Status of the LEDs: Decimal 3 (F15 2 1,
F16 2 2)

Note

If a set consists of 16 LEDs and the status of an LED is shown as binary, 16 bits or 2 bytes
are returned. The return value is thus between 0 and 65535 (216 or OxFFFF).
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3.4.1.4 Language selection for key devices

In order to ensure that all characters for key devices are displayed correctly in connection
with the KeyTools, the languages for dialogs and keyboard layout must be set to "United
States-International".

Note

For SIMATIC IPCs with PhoneKeyPad and installed software, "United States-International”" is
set.

Procedure

1. Open the "Text Services and Input Languages" dialog.
wa Text Services and Input Languages l—'i—r

General | Language Bar | Advanced Key Settings |

Default input language

Select one of the installed input languages to use as the default for all input
fields.

| English (United States) - United States-Intemational -

Installed services

Select the services that you want for each input language shown in the list.
|Use the Add and Remove buttons to modify this list.

:m German {Gemary) -
‘i Keyboard |
‘e w German
[ English {United States) —_—
=) Keyboard 2 Add...
“ew LS
e w United States-Intemational
E Spanish {Spain, Traditional Sort)
= Keyboard
i w Spanish
E French (France)
[ 'Ke!!ward ol

i QK i Cancel |

L A

2. Under "Default input language" and "Installed services", activate the "United States-
International" setting. Significance:

"Default input language" defines the dialog language
"Installed services" defines the language for the keyboard layout

The table below is a list of all the characters for all keys that are programmed in the table
tab15w.pad and in PhoneKeyPad.

In the SIMATIC IPC KeyToolsPhone window under the Open KeyPad menu, you can use
the "KeyPads15w.exe" tool to re-program the keys F1 to F36.

The other keys are not programmable.
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The table shows the default programming with the factory settings. Whereby the first three
lines specify the key function when the PhoneKeyPad is deactivated, and the next two lines

show the key function when the PhoneKeyPad is activated.

Name Code Check box Display/function
(Hex) Ox
1! 1E - 1
L Shift/R Shift !
R Alt i
R Alt + L Shift / R Shift !
PhoneKeyPad \@#%2N\";<>()1{}€$&§"°~|_1
PhoneKeyPad + LShift \@#%?2N\";;<>()1{}€$&§"°~|_1
2@ 1F - 2
L Shift/R Shift @
R Alt 2
PhoneKeyPad abc2
PhoneKeyPad + LShift ABC2
3# 20 - 3
L Shift/R Shift #
R Alt 3
PhoneKeyPad def3
PhoneKeyPad + LShift DEF3
4% 21 - 4
L Shift/R Shift $
R Alt o
R Alt + L Shift / R Shift £
PhoneKeyPad ghi4
PhoneKeyPad + LShift GHI4
5% 22 - 5
L Shift/R Shift %
R Alt €
PhoneKeyPad kIS
PhoneKeyPad + LShift JKL5
67 23 - 6
L Shift/R Shift A
R Alt Ya
PhoneKeyPad mno6
PhoneKeyPad + LShift MNOG6
7& 24 - 7
L Shift/R Shift &
R Alt Va
PhoneKeyPad pqrs7
PhoneKeyPad + LShift PQRS7
8* 25 - 8
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Name Code Check box Display/function
(Hex) Ox
L Shift/R Shift *
R Alt %
PhoneKeyPad tuv8
PhoneKeyPad + LShift TUV8
9 ( 26 - 9
L Shift/R Shift (
R Alt '
PhoneKeyPad wxyz9
PhoneKeyPad + LShift WXYZ9
0) 27 - 0
L Shift/R Shift )
R Alt ’
PhoneKeyPad +-*/=0
PhoneKeyPad + LShift +-*/=0
Return 28 - Return
Escape 29 - Escape
Backspace 2A - Backspace
Tab 2B - Tab
-_alA 2D - -
L Shift/R Shift _
a/A & PhoneKeyPad LED off-a, b, c, d, ...
a/A & PhoneKeyPad LEDon-A,B,C, D, ...
> 37 -
L Shift/R Shift >
a/A & PhoneKeyPad LED off - .,
a/A & PhoneKeyPad LEDon-.,
DEL 4C - Delete
Page Up / Home 4B - Page Up
Page Down / End 4E - Page Down
Cursor right 4F - Right Arrow
Cursor left 50 - Left Arrow
Cursor down 51 - Down Arrow
Cursor up 52 - Up Arrow
HELP 0B L Alt hH & LAIt
ACK 3A L Alt F1 & LAIt
F1 3A - F1
F2 3B - F2
F3 3C - F3
F4 3D - F4
F5 3E - F5
F6 3F - F6
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Name Code Check box Display/function
(Hex) Ox
F7 40 - F7
F8 41 - F8
F9 42 - F9
F10 43 - F10
F11 44 - F11
F12 45 - F12
F13 3A LSHIFT F1 & LShift
F14 3B LSHIFT F2 & LShift
F15 3C LSHIFT F3 & LShift
F16 3D LSHIFT F4 & LShift
F17 3E LSHIFT F5 & LShift
F18 3F LSHIFT F6 & LShift
F19 40 LSHIFT F7 & LShift
F20 41 LSHIFT F8 & LShift
F21 42 LSHIFT F9 & LShift
F22 43 LSHIFT F10 & LShift
F23 44 LSHIFT F11 & LShift
F24 45 LSHIFT F12 & LShift
F25 3A LCtrl F1 & LCtrl
F26 3B LCtrl F2 & LCtrl
F27 3C LCtrl F3 & LCtrl
F28 3D LCtrl F4 & LCtrl
F29 3E LCtrl F5 & LCtrl
F30 3F LCtrl F6 & LCtrl
F31 40 LCtrl F7 & LCtrl
F32 41 LCtrl F8 & LCtrl
F33 42 LCtrl F9 & LCtrl
F34 43 LCtrl F10 & LCtrl
F35 44 LCtrl F11 & LCtrl
F36 45 LCtrl F12 & LCtrl
SHIFT 0 LShift
ALT 0 LAIt Alt
CTRL 0 LCtrl Ctrl
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3.4.2 PhoneKeyPad

The alphanumeric input keys of the key devices have the same operating concept as the
keypad of a cell phone. Each system key is assigned several letters and special characters
of the alphabet and one number.

The "PhoneKeyPad" program provides supports by displaying the character selection with a
preview window, which is shown directly below each input field.

The following figure shows an example for a preview window.

Search System [C)

Configuring the PhoneKeyPad
Open the PhoneKeyPad using the "PhoneKeyPad" icon in the system tray.

Enabling/disabling the PhoneKeyPad

The "PhoneKeyPad" and "Shift" functions can be enabled and disabled via the shortcut
menu of the "PhoneKeyPad" icon in the system tray.

disable PhoneKeypad

enable PhoneKeypad

disable Shift Function

enable Shift Function

Functional description

e "disable PhoneKeyPad": Disables the PhoneKeyPad functions. Only the standard
keyboard functions are available. The preview feature is disabled.

e "enable PhonekeyPad": Enables the PhoneKeyPad functions.

e "disable Shift Function": Disables the shift function in combination with the <Home>,
<End> and <Ins> keys.

e "enable Shift Function": Enables the shift function in combination with the <Home>,
<End> and <Ins> keys.

=5

About SIMATIC IPC PhoneKe

SIMATIC IPC Phonekeypad

Product: SIMATIC IPC Phonekeypad 1.0.0.0
Revigion level: % 1.0.0.0

Copyright [C] 2012, Siemens AG. All rights
reserved.
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A.1 Service and support

You can find additional information and support for the products described on the Internet at
the following addresses:

® Technical support (http://www.siemens.de/automation/csi_en_WW)

® Support request form (http://www.siemens.com/automation/support-request)

® After-sales information system for SIMATIC PC / PG (http://www.siemens.com/asis)

e SIMATIC Documentation Collection (http://www.siemens.com/simatic-tech-doku-portal)

® Your local representative
(http://www.automation.siemens.com/mcms/aspa-db/en/Pages/default.aspx)

® Training center (http://sitrain.automation.siemens.com/sitrainworld/? AppLang=en)

Industry Mall (http://mall.automation.siemens.com)

When contacting your local representative or Technical Support, please have the following
information at hand:

® Order number of the device (MLFB)
® BIOS version (industry PC) or image version (HMI device)
® |nstalled additional hardware

e |nstalled additional software

Tools & downloads

Please check regularly if updates and hotfixes are available for download to your device. The
downloads are available on the Internet under "After Sales Information System SIMATIC
PC/PG" (see above).
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A. 1 Service and support
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